NOTE TO AUTHORS:

If answers to your questions are not found within the Guidelines, please address your inquiries to QHR-Journal@nurs.utah.edu (please do not send inquiries to other/additional QHR email addresses). You may also telephone our office at 801-585-5378. Thank you for your cooperation.

When APA rules and QHR guidelines conflict, follow QHR.
# TABLE OF CONTENTS

**About Qualitative Health Research (QHR)** ................................................................. 4  
About QHR ...................................................................................................................... 4  
Contact Us ..................................................................................................................... 5  
Reviewers Needed ......................................................................................................... 6  

**Permissions** ............................................................................................................... 7  
Copyright Permission ................................................................................................. 7  
Exclusive License to Publish (ELP) ............................................................................ 7  

**Journal Style** ........................................................................................................... 8  
General Information .................................................................................................... 8  
  Important Considerations ......................................................................................... 8  
  General Style ........................................................................................................... 8  
  Confidentiality and Protection of Identity .............................................................. 9  
  Word Choices ........................................................................................................... 9  
  Common Problems ................................................................................................. 10  
Basic Document Preparation ...................................................................................... 12  
  Document Setup and Formatting ............................................................................ 12  
  Order of Manuscript Elements .............................................................................. 12  
  Formatting of Manuscript Elements ...................................................................... 12  
  What You Should Not Do ....................................................................................... 16  
  “Review” Your Manuscript ..................................................................................... 16  
  Prior to Submission ................................................................................................ 16  

**Keywords** .................................................................................................................. 17  

**Manuscript Preparation** (See also, Tables and Figures, pp. 29-32) ....................... 21  
  Elements of a Manuscript ......................................................................................... 21  
Preparation of Manuscript Elements .......................................................................... 22  
  Title Page .................................................................................................................. 22  
  Abstract and Keywords ............................................................................................ 23  
  Main Manuscript ...................................................................................................... 23  
  References ................................................................................................................. 24  
  Appendices ................................................................................................................. 25  
  What You Should Not Do ....................................................................................... 25  

**Final Checklist for Submission** ................................................................................ 25  
  General Manuscript Preparation ............................................................................. 25  
  Quotations .................................................................................................................. 26  
  References and Citations ............................................................................................ 26
# Instructions for Accepted Manuscripts

- **Tables**: 27
- **Figures**: 27
- **Instructions for Accepted Manuscripts**: 28
- **Tables**: 29
- **Figures**: 31
- **Book Review Preparation**: 33
- **Letter to the Editor Preparation**: 33
- **Guest Editorial Preparation**: 34
- **Sample Manuscripts**: 35
  - Article for Review: 35
  - Accepted Article: 42
  - Book Review: 49
  - Letter to the Editor: 51
  - Guest Editorial: 53
- **Manuscript Review**: 55
  - Review Criteria: 55
  - Review, Decision, and Revision Process: 55
- **Submission**: 58
  - How to Submit a New Manuscript: 58
  - How to Submit a Revised Manuscript: 59
- **Publication Information**: 60
  - Publish Ahead of Print: 60
  - Policy on NIH Publication Requirements: 60
ABOUT QUALITATIVE HEALTH RESEARCH (QHR)

Editor: JANICE M. MORSE, RN, PhD (ANTHRO), PhD (NURS), FAAN
University of Utah College of Nursing, Salt Lake City, Utah, USA

QUALITATIVE HEALTH RESEARCH, widely referred to as QHR, is an international, interdisciplinary, refereed journal for the enhancement of health care. Published monthly, it is designed to further the development and understanding of qualitative research methods in health care settings. The journal is an invaluable resource for researchers, practitioners, academics, administrators, and others in the health and social service professions, and graduate students who seek examples of qualitative methods.

COMPREHENSIVE, TIMELY COVERAGE FROM A VARIETY OF PERSPECTIVES

Issues of QHR provide readers with a wealth of information, including articles covering research, theory, and methods in the following areas:

- Description and analysis of the illness experience
- Health and health-seeking behaviors
- The experiences of caregivers
- The sociocultural organization of health care
- Health care policy
- Related topics

Articles in QHR examine an array of timely topics such as chronic illness; risky behaviors; patient–health professional interactions; pregnancy and parenting; substance abuse; food, feeding, and nutrition; living with disabilities; milestones and maturation; monitoring health; children’s perspectives on health and illness, and much more. In addition, the journal addresses a variety of perspectives, including cross-cultural health, family medicine, health psychology, health social work, medical anthropology, sociology, nursing, pediatric health, physical education, public health, and rehabilitation.

We also consider critical reviews; articles addressing qualitative methods; and commentaries on conceptual, theoretical, methodological, and ethical issues pertaining to qualitative inquiry.

PUBLISHER

QHR is published by Sage Publications, Inc., 2455 Teller Road, Thousand Oaks, CA 91320, USA; www.sagepub.com; telephone 800-818-7243.
EMAIL:

Editor, Dr. Janice Morse  QHR-Editor@nurs.utah.edu
Technical Editor, Dori Fortune  QHR-TE@nurs.utah.edu
Journal Editorial Office  QHR-Journal@nurs.utah.edu

TELEPHONE AND FACSIMILE (FAX):

Phone  801-585-5378
Fax   801-587-9838
Attention: Dori Fortune

MAILING ADDRESS:

Janice Morse [or Dori Fortune, as appropriate]
Qualitative Health Research
University of Utah College of Nursing
10 South 2000 East
Salt Lake City UT 84112-5880 USA

VISIT US ON THE WEB:

http://qhr.sagepub.com/

PLEASE DO

- send all QHR-related email messages to only one of the email addresses listed above.
- direct all manuscript-related faxes to the attention of Dori Fortune.
- direct all manuscript-related documents to the attention of Dori Fortune.

PLEASE DO NOT

- submit manuscripts via email.
- send email messages to two or more addresses simultaneously; doing so will cause a significant delay in the QHR response.
- send email messages to “janice.morse@...” or “dori.fortune@...”; doing so will cause a significant delay in the QHR response.
- send query letters/email messages asking if we would be interested in your manuscript. After ensuring that your manuscript complies fully with these Guidelines, the only way to determine if the manuscript is suitable for QHR is to submit it (online) for consideration.
Reviewers must have a strong background in qualitative health research and/or qualitative methods. They must have a willingness to share their expertise by evaluating manuscripts and providing feedback for authors to assist them in strengthening their articles.

What's in it for you?
You have the prerogative of reading prepublication articles in your methodological or substantive areas, and assisting in molding the literature in your field. Also, we give you copies of the other reviews received, so you can review the general consensus about the decision, and in doing so improve your own research, reviewing, and writing skills.

Do you have to have a doctorate?
No—but if you are a doctoral student we recommend that you do the first few reviews jointly with your supervisor or some other experienced reviewer, so you can learn the "ins and outs."

Qualitative Health Research (QHR) is an international journal published monthly by Sage Publications. Research articles, developments in qualitative methods, and Pearls, Pith, and Provocation—discussion articles on qualitative ethics and other issues—are reviewed. Keynote addresses, editorials, and book reviews are also published.

If you would like to join the review board for QHR, please email your curriculum vitae (CV) and complete contact information to QHR-Journal@nurs.utah.edu.

Thank you! We look forward to hearing from you!

Janice M. Morse
Editor
COPYRIGHT PERMISSION

If your article contains any material (text, tables, photographs, images, figures) that has been published previously—even if you were the author—you might need to obtain permission to use the material in your article. For guidelines on reprint permission requirements, visit http://www.sagepub.com/repository/binaries/guidelines/PermissionsGuidelines.pdf

Accepted articles requiring copyright permission will not be submitted to the publisher until written permission from the copyright holder is received by QHR from the author (electronic permission, such as email or a scanned document, is acceptable).

If permission is necessary, we strongly recommend that you submit your request at the earliest possible date, because the process is frequently lengthy. Permission must be requested from the holder of the copyright, which is usually the publisher, not the author or journal.

To request copyright permission from Sage Publications for articles published in QHR, do not contact QHR. Access the article online on the journal’s Web site at http://www.qhr.sagepub.com and select the “Request Permission” link. Permission may also be requested by contacting the Copyright Clearance Center via their Web site at http://www.copyright.com, or via email at info@copyright.com.

If you do need to request reprint permission (from Sage Publications or any other publisher), you may download a generic request template at the following URL: http://www.sagepub.com/repository/binaries/RequestForPermissionForm.pdf

Once you have obtained written reprint permission, submit it along with the original manuscript submission or, if you have obtained it after submitting the manuscript, submit it to QHR, being sure to refer to your manuscript ID number:

By email: Send it to QHR-TE@nurs.utah.edu
By facsimile: Fax it to 801-587-9838, Attention Dori Fortune

EXCLUSIVE LICENSE TO PUBLISH

Sage Publications requires a completed and signed Exclusive License to Publish (ELP) form from the author(s) of every article, keynote address, book review, letter to the editor, or other material published in QHR. It is to be submitted to QHR when notice is received that the article has been accepted for publication. The ELP, also known as a Contributor Form, is to be completed by the corresponding author on behalf of all authors.

The ScholarOne Manuscripts / SageTrack system will be triggered to automatically send you ELP information (via email), including instructions to access and complete the form, immediately after an “accept” decision is sent to you. The subject line of the email will read: “ACTION NEEDED: Contributor Form.” If you do not receive this notification, or if you accidentally delete it, you may request a blank (.pdf) ELP form by contacting QHR at QHR-Journal@nurs.utah.edu. Under these circumstances, please take the steps listed below to submit your form:

Print the form, complete it (be sure to answer all questions), and sign it. Write your manuscript ID number in the upper right corner of the first page of the form (e.g., QHR-2011-0XXX). Submit the first 2 pages only to QHR by one of the following methods:

By email (preferred): Scan the completed form, save it to your computer, and send it as an attachment to: QHR-Journal@nurs.utah.edu.

By facsimile: If you use this method, please send an email alerting us to the pending arrival of the fax (QHR-Journal@nurs.utah.edu). Fax the completed document to:
801-587-9838
Attention: Dori Fortune
By mail/post: Mail the completed document to:
Dori Fortune
University of Utah College of Nursing
10 S. 2000 E.
Salt Lake City UT 84112-5880 USA

- Note that the corresponding author completes and signs the form on behalf of all coauthors of a particular manuscript; it is not necessary to obtain the signature of each author. Remember that all author names must appear on the first page of the form. Please print legibly!
- Submit only the first 2 pages of the completed form.
- Do not submit a completed Exclusive License to Publish form unless and until you receive word that your manuscript has been accepted for publication.

JOURNAL STYLE

GENERAL INFORMATION

This section of the Guidelines covers matters of QHR journal style, which are not subject to author preference; adherence is required.

Note: If you still have questions after carefully reading these instructions, please refer to the sample manuscripts (there are several types) beginning on page 35 before contacting the QHR office.

IMPORTANT CONSIDERATIONS

- Qualitative Health Research is a peer-reviewed journal. Only complete, finished manuscripts should be submitted for consideration.
- We do not publish stand-alone abstracts, quantitative studies, manuscript outlines, pilot studies, manuscripts-in-progress, letters of inquiry, or literature reviews. Research articles must be pertinent to health.
- Write both the abstract and the text of your manuscript in first-person, active voice.
- For best results, review this entire document prior to preparing and submitting your manuscript.
- Proper manuscript preparation will speed the peer-review process for your manuscript, and will facilitate a smoother production process if it should be selected for publication.
- Improper manuscript preparation could result in burdensome revisions, lengthy delays in the review and production processes, and the possible rejection of your manuscript.

GENERAL STYLE

We ask authors considering submission to QHR to review these guidelines, survey several issues of the journal, and make their own decision regarding the “fit” of their article for QHR’s mission. Please refrain from inquiring to ask if we are interested in your particular manuscript or idea.


Many universities and private organizations have Web sites devoted to APA style. However, when guidelines found on those sites, or in the APA Publication Manual, conflict with QHR Guidelines, you must follow the QHR Guidelines.
CONFIDENTIALITY AND PROTECTION OF IDENTITY

QHR is committed to protecting the identity and confidentiality of research study participants. With the exception of participatory action research (PAR), no information that could potentially allow identification of a participant—or even a specific study site—should be included in a submitted manuscript or, subsequently, included in a published article.

If the use of participant names is absolutely necessary for reader understanding, each study participant referred to in the manuscript should be assigned a pseudonym. Study sites, such as hospitals, clinics, or other organizations, should not be named, but instead should be described; for example: “Study participants were recruited from the coronary care unit of a large metropolitan hospital on the eastern seaboard of the United States.” Authors who include participant names and/or photos/images in which individuals are identifiable must submit written permission from the participants to do so—no exceptions. Permission to use photographs should contain the following verbiage: “Permission is granted to use, reproduce, and distribute the likeness/photograph(s) in all media (print and electronic) throughout the world in all languages.”

To protect author anonymity during the review process, author citations in the text should include only the word “Author” and the year: (Author, 2008). Author references in the reference list should also include only the word “Author” and the year: Author. (2008). (See the section on references for more details.)

WORD CHOICES

It is always best to use the most precise language possible to convey important data, concepts, and findings. Because QHR is an international journal published in U.S. English, there is the added need to avoid commonly used English terms (colloquialisms, slang) that might be misinterpreted by or confusing to readers whose first language is something other than English.

<table>
<thead>
<tr>
<th>Word or Phrase</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>as</td>
<td>Do not use this word when your meaning is because.</td>
</tr>
<tr>
<td>amongst</td>
<td>Use among instead.</td>
</tr>
<tr>
<td>as regards</td>
<td>Use with regard to, or regarding instead.</td>
</tr>
<tr>
<td>can’t, don’t, and so forth</td>
<td>Use cannot, do not, and so forth. Do not use contractions unless they are part of a quotation.</td>
</tr>
<tr>
<td>Caucasian</td>
<td>Use White instead, capitalized.</td>
</tr>
<tr>
<td>due to</td>
<td>Use because of instead.</td>
</tr>
<tr>
<td>etc.</td>
<td>Use and so forth instead.</td>
</tr>
<tr>
<td>feel</td>
<td>It is appropriate to use this word when referring to a physical sense or state of mind; do not use it when your intent is think or believe.</td>
</tr>
<tr>
<td>female(s)</td>
<td>Please use woman or women instead, whenever possible and appropriate.</td>
</tr>
<tr>
<td>firstly, secondly, thirdly</td>
<td>Use first, second, and third instead.</td>
</tr>
<tr>
<td>further</td>
<td>This word is appropriately used when referring to distance, or perhaps with respect to “furthering” something. At the beginning of a new sentence, when writing of something in addition to something already stated, it is more appropriate to use furthermore, moreover, in addition, or additionally.</td>
</tr>
<tr>
<td>Importantly</td>
<td>Do not use this word unless it is part of a quotation.</td>
</tr>
<tr>
<td>in order to</td>
<td>Use to instead.</td>
</tr>
<tr>
<td>Interestingly</td>
<td>Do not use this word unless it is part of a quotation.</td>
</tr>
<tr>
<td>last</td>
<td>Use last or finally instead.</td>
</tr>
<tr>
<td>male(s)</td>
<td>Please use man or men instead, whenever possible and appropriate.</td>
</tr>
<tr>
<td>may</td>
<td>Do not use this word in place of might. Use may for permission, might for possibility, and can for ability.</td>
</tr>
</tbody>
</table>
**on the one hand / on the other hand**  Do not use these terms in your writing.

**over**  Be careful not to use this word when the intended meaning is *more than*.

**paper**  Use *article* instead.

**since**  *Since* is the appropriate word to use when referring to the passage of time; do not use it when your intended meaning is *because*.

**towards**  Use *toward* instead.

**upon**  Use *on* instead

**U.S./United States**  Use *U.S.* only as an adjective; in all other instances, spell out *United States*. The same rule applies to *UK/United Kingdom.*

**while/whilst**  Use *while* when referring to concurrent events; do not use it when your intent is *whereas, although, or even though*. Do not use *whilst*.

### COMMON PROBLEMS

**Acronyms**  The full spelling of the related words must precede the first usage of an acronym (even if you think everyone knows what the acronym stands for), followed by the acronym in parentheses; e.g., *World Health Organization (WHO)*. Thereafter you may use the acronym alone: *WHO*. Avoid the overuse of multiple acronyms.

**Anthropomorphism**  Anthropomorphism occurs when human characteristics are attributed to things not human. For example: *This study used a grounded theory approach . . .* Obviously, a study cannot “use” anything. It would be more appropriate to write, *In this study we used a grounded theory approach . . .* Eliminate anthropomorphism from your manuscript.

**Back-to-back parentheses**  Incorrect: *(xxx) (yyy)*/ Correct: *(xxx; yyy)*

**Bad beginnings**  Do not begin sentences—and especially paragraphs—with *and, yet, or but*. Use caution when beginning a sentence, and never begin a paragraph, with *however*.

**Capitalization**  Capitalize proper names. Do not capitalize words unnecessarily, such as titles and ranks (e.g., director, professor, doctor, chairperson), or themes, categories, concepts, and so forth. (See also Title Case, below)

**Ellipses**  Ellipses ( . . . ) are to be used only to represent missing words from quotations. Do not use them to represent pauses in speech.

**Hyphenation**  Refer to the *APA Publication Manual*, 6th edition, for an excellent explanation of the proper use of hyphens and dashes; *do not* depend on Word’s “Spell Checker” feature for decisions on hyphenation. With few exceptions (see *APA*), words beginning with *co, non, pre, post, re, semi, socio, and sub* do not require hyphenation.

**Horizontal lines**  Do not place horizontal lines in your manuscript. If footnote separator lines appear, remove them.

**Inconsistent writing style**  When reviewing your manuscript prior to submission, watch for inconsistent writing style. This is especially important for manuscripts having two or more authors.

**Irrelevant data**  Page space in the journal is precious. Refrain from including interesting but irrelevant data or commentary.

**Jargon**  *QHR* readers come from a wide variety of disciplines and backgrounds, and therefore might not be familiar with the terminology related to your particular field or discipline. If you must include jargon, be sure to explain it clearly the first time a discipline-specific word is used. Avoid the overuse of jargon.
Non-English words: The first time a non-English word is used, italicize it. Thereafter, use only Roman font. All non-English words must be explained or defined in the text. Include English translations of all non-English titles in the reference list (refer to APA for instruction on how to do this).

Paragraph length: Paragraphs may be no longer than 1 double-spaced, 8.5 x 11-inch page. Avoid paragraphs of only two or three sentences in length; combine them as necessary to make paragraphs of more appropriate length.

Participant characteristics: Under no circumstances should you include individual participant characteristics in your manuscript. Group participant characteristics. In most cases it is best to write group characteristics into the text rather than placing them in a table (use whichever format takes the least amount of page space).

Repetition: Avoid it! Make your writing as “tight,” precise, and concise as possible. Avoid including the same facts, conclusions, or information in multiple places in the text (this does not mean you cannot summarize, of course). Avoid overuse of the same phrases, and avoid repeating certain characteristics of your sample; for example: Twelve-year-old boys are perceived as . . . This is often a problem for 12-year-old boys. Also, 12-year-old boys are . . .

Run-on sentences: Avoid long, wordy, complex sentences.

Spacing: Use no spaces before, and only a single space after periods (.), commas (,), colons (:), semicolons (;), question marks (?), and closing quotation marks (”). All line spacing (except text within figures) should be set at exactly double, with 0” before and 0” after.

Special formatting: Never use any coding or formatting in your manuscript that is not called for in these Guidelines.

Spelling: QHR is published in U.S. English. For best results, set the language of your document to U.S. English when you are establishing all other document setup requirements. Note the correct spelling of a few commonly misspelled words: health care (two words); keywords (one word); semistructured (one word, no hyphen). Also, refer to the section on hyphenation, above. QHR uses Merriam-Webster’s Collegiate Dictionary (2005) as our spelling reference.

Title Case: Title case is properly created by capitalizing:
- the first letter of the first word
- the first letter of the first word after a colon (:), period (.), or em dash (—)
- all important words, and
- all words containing four or more letters

Verb tense: Things that happened, were said, or were written in the past should be written about in the past tense. When writing about what is included in your article, use the present tense rather than the future tense (e.g., In this article we present, rather than In this article we will present).

Voice: Write in the first-person, active voice (use of third-person passive voice is not acceptable). When there are two or more authors, avoid the use of “I” statements.

Word confusion and substitution: Research studies and articles about research studies are two separate things. Do not confuse the meaning of these words in your writing.
BASIC DOCUMENT PREPARATION

See also a variety of sample manuscripts beginning on page 35.

Note: Do not use any coding or formatting that is not described within these Guidelines!

DOCUMENT SETUP AND FORMATTING

Document file type Submit only documents created in Microsoft Word, and only with the regular file extension of .doc (do not submit documents with .docx, .docm, .rtf, .pdf or other extensions).

Paper size Letter, 8.5 x 11 inches, with portrait orientation

Margins 1 inch (1") on all sides

Line numbers None

Line spacing Exactly “double,” with 0” before and 0” after

ORDER OF MANUSCRIPT ELEMENTS

Compile the elements of your manuscript in the following order:

Document 1:
  Title page (required)

Document 2:
  Abstract and keywords (required)
  Main manuscript text (required)
  Notes (if any)
  References (required)
  Appendices (if any)
  Tables (if any)

Document 3:
  Figure 1 (if any)

Document 4:
  Figure 2 (if any; and so forth, with each subsequent figure in a separate document)

FORMATTING OF MANUSCRIPT ELEMENTS

Note: For ease in locating needed information, the various elements are listed below in alphabetical order, and not in the order of anticipated use.

Dialogue Presentation of participant dialogue (i.e., two or more “speakers”) should be set as block quotes/excerpts, indented by ½ inch from the left margin. Do not use bullets or hanging paragraphs. Begin the narrative of each speaker on a new line. The first time a speaker name is used, type it in full, followed by an appropriate abbreviation in parentheses prior to the colon; thereafter, use only the abbreviation for the speaker name. Refer to the sample manuscripts for an example of dialogue presentation.

Ellipses / ellipsis points Almost every manuscript contains ellipses. They are used to indicate missing words in quotations, and are to be created in a very specific manner. The proper way to create ellipsis points is as follows:

Three (3) dots, preceded, divided, and followed by spaces (i.e., space dot space dot space dot space), like . . . this.

If it is necessary to indicate missing words between sentences (instead of in mid-sentence):

Place a period (full stop) at the end of the first sentence, then format the ellipsis points as noted, and begin the next sentence (with a capital letter) immediately after the last space (i.e., period space dot space dot space dot space). . . . Like this.
Font size: text 
Use 12-point font for everything except text in tables, figures, and (if applicable) conversation analysis.

Font size: tables and figures
Use only 8-point font in tables and figures.

Font style: headings, title page, abstract, keywords, tables, and figures
Use Gill Sans font style for all of these. This includes figure/table numbers, titles, text within the figures/tables, and citations or explanatory notes below the figures/tables (if any). Note: If you do not have Gill Sans font on your computer, please use Arial instead.

Font style: main manuscript
Use Times New Roman font for the main body text. Also, use Times New Roman font for the text (not the headings) of author’s notes, acknowledgments, declarations of conflicting interests, funding statements, footnotes, and bios.

Italics should be used only
- as appropriate in the reference list (see APA);
- as appropriate in level-2, -3, and -4 headings; and
- to introduce non-English words, or unusual new concepts (2 to 3 words), and then only when the new word or concept is first introduced in the manuscript; subsequent use of the same word(s) should be in regular Roman font.

Headings
All headings, without exception, are to be set in Gill Sans, 12-point font. (Use Arial if you do not have Gill Sans on your computer.) QHR uses 4 distinct levels of headings (H = Heading), including:

<table>
<thead>
<tr>
<th>H Level</th>
<th>Formatting (Note: All headings should be double-spaced, just like the regular text)</th>
</tr>
</thead>
<tbody>
<tr>
<td>H1</td>
<td>Flush Left, Bold Text, in Title Case</td>
</tr>
<tr>
<td>H2</td>
<td>Flush Left, Italicized Text, in Title Case</td>
</tr>
<tr>
<td>H3</td>
<td>Flush left, italicized text, in sentence case, ending with a period.</td>
</tr>
<tr>
<td></td>
<td>At this level, the paragraph text begins immediately after the heading, instead of on the next line. The heading is part of the paragraph. Use this heading only if you have a total of four (4) heading levels. Note: Try to avoid the use of H3 if possible, and use only H1, H2, and H4 (see below).</td>
</tr>
<tr>
<td>H4</td>
<td>Indented (.5’’), italicized text, in sentence case, and ending with a period.</td>
</tr>
<tr>
<td></td>
<td>At this level, the paragraph text begins immediately after the heading, instead of on the next line. The heading is part of the paragraph.</td>
</tr>
</tbody>
</table>

Use at least two heading levels:
- For manuscripts with 2 heading levels, use H1 and H2
- For manuscripts with 3 heading levels, use H1, H2, and H4 (not H3)
- For manuscripts with 4 heading levels, use H1, H2, H3, and H4

Be aware of limitations on the use of heading levels H2, H3, and H4: You are not required to use an H2 heading below any given H1 heading, but if you do, you must use two or more H2 headings; you cannot use just one. The same is true for H3 headings below any given H2 heading, and for H4 headings below any H2 or H3 heading.

Justification of margins
All text should be left justified.

Length of manuscript
There is no predetermined word or page limit. Provided they are “tight” and concise, without unnecessary repetition and/or irrelevant data, manuscripts should be as long as they need to be.

The editor might require a reduction in length if the manuscript contains material that does not add anything useful to the topic being discussed. Limits might be imposed on the number/size/length of tables, figures, reference lists, and appendices.

Line spacing
Everything, in all elements of the manuscript, from the title page through the references and tables (if any), must be exactly double spaced. The only exception: Text within a figure should be single spaced.
To set double spacing, go to Format > Paragraph > Line spacing > Double. (Note that the “Before” and “After” settings should both be “0 pt”.)

Lists  
Vertical lists (i.e., listed down the length of the page) should be either simple dot bullets or bullets numbered 1., 2., 3., and so forth. Leave a blank, double-spaced line after all lists.

Paragraphs  
Paragraphs are to flow, one after the other, without additional line breaks (with few exceptions; see below), and with no extra space between paragraphs. Leave a blank (double-spaced) line between the abstract and the keywords. Leave a blank line after (not before) each block quote, numbered list, or bulleted list. Leave a blank line between block quotes if you have placed two or more in succession.

Indent the first line of every new paragraph by ½ (.5) inch, except:
- the first line of the abstract or the keywords.
- the first (opening) paragraph of the manuscript text.
- paragraphs immediately after level-1 and level-2 headings.
- paragraphs beginning with level-3 headings.

Use Word’s Format > Paragraph function to set paragraph first-line indentations, but apply this paragraph by paragraph, and not to the entire document.

Use Word’s Format > Paragraph function to set block quote/excerpt and bulleted/numbered list indentations; note that block quotes/excerpts and lists are to be completely indented (not just the first line) by .5 inches from the left margin only; do not indent from the right side.

Quotation marks  
In general, use double quotation marks (e.g., “Xxxx.”) to set off quotations appearing within regular paragraphs, and to set off words being used with “special” meaning (or unusual spelling to convey special meanings within the text; e.g., “busy-ness”). Do not use quotation marks around quotations presented as block quotes/excerpts.

In regular paragraphs, use single quotation marks to set off a quote within a quote (e.g., ‘Xxx, ‘Yyy,’ xxxx.’).

Note that when closing quotation marks coincide with a comma or period (full stop), the quotation marks go outside (after) the comma or period: “Quotation. . . last word.”

Quotations  
Quotations of fewer than 40 words should be surrounded by double quotation marks (“) and included within the regular sentences of a paragraph. Internal quotations within quotations of fewer than 40 words should be set apart with single quotation marks (‘).

Quotations of 40 or more words should be set as separate paragraphs, with the entire quotation indented .5 inches from the left margin (this is also referred to as a “block quote” or “excerpt”). Do not use quotation marks for block quotes unless there is a separate, internal quotation within the larger quotation; in that case, use double quotation marks (”) for the internal quotation only. Make sure all quotations are properly capitalized and punctuated.

Format the indentation for block quotes with Word’s Format > Paragraph feature.

See the special section, below, for instructions on formatting conversation analysis.

Seriation  
Seriation refers to “numbered” lists appearing in sentences of regular text (in other words, across the page rather than in a vertical list). The proper seriation style for manuscripts submitted to QHR is (a), (b), (c), and so forth (lower case letters, enclosed in parentheses).

Spelling  
See “Common Problems,” above. Exceptions to the use of U.S. English include (a) direct quotes from written, published material, and (b) titles in the reference list (which should be spelled exactly as published).
CONVERSATION ANALYSIS

**Note:** This specific instruction *does not pertain* to “regular” quotations, excerpts, or block quotes. If you have not conducted conversation analysis in your study, *do not use this formatting for your quotations.*

For your excerpts of conversation analysis, you will need to create tables with very specific formatting. Use a level-2 heading, but bolded, with the word “Extract” and the extract number. You may also use a colon with a subheading, if you wish. Use the following steps to format your sections of conversation analysis.

Create a table with the left border of the table aligning with the left margin of the page. Set only two columns. Highlight the entire table and set the font for *Courier* style, 9-point font (this is critical).

In column 1, number the lines, beginning with “1.” When you have numbered as many lines as you think you will need, drag the column separator as far to the left as it will go without forcing double-digit numbers onto two lines (i.e., make the first column as narrow as possible). Then, drag the far right border of the table to the left, narrowing the table so that the entire width of the table is exactly $3\frac{3}{8}$ inches wide.

Begin typing the excerpt on line 1 of column 2. If you need to use speaker names, place them in this same space, followed by a colon and a single space, before the quotation begins. Use abbreviations for speaker identification as much as possible, to conserve space (see the sample, below). Type across the line, ending as close to the right edge as possible, then drop down to the next line and continue typing. Do not allow the typing to “wrap” within the same row. After typing the entire excerpt, you might need to go back and manually change the first letter of some rows (if your computer automatically capitalized it) to lower case letters (see below).

Manipulate the text within the rows of column 2 to achieve your desired alignment. Place the symbols for your chosen transcription conventions in the type as you go.

To delete rows, highlight the selected row(s), and to go Table > Delete rows. To add rows, place your cursor in the last line of the table, and hit the tab key until you have as many rows as you need.

“Hide” the lines of the table. Format the entire table for double line spacing (do not use hard returns).

**Sample excerpt of conversation analysis:**

**Excerpt 1: Emilie**

1 Interviewer (I): What happened after
2 that?
3 Emilie (E): Well, after that I
4 walked to the corner without my
5 friend, because he took too long
6 getting ready to go.
7 I: How did you feel walking there
8 by yourself?
9 E: I was a little bit nervous,
10 ‘cause I’m not used to going places
11 by myself.

Note that the sample does not contain transcription symbols. When these symbols are used, cite and reference the transcription style, add a note explaining the symbols if only a few are used, or add a note advising the reader to contact the corresponding author for a key to the symbols.
WHAT YOU SHOULD NOT DO

Conversation analysis
- Do not include a list of the transcription conventions in the manuscript if more than 5 symbols have been used.

Ellipses
- Do not use the “Insert > Symbol” function in Word to enter ellipses.
- Do not use ellipses to indicate pauses in speech.
- Do not place ellipses within parentheses ( . . . ) or brackets [ . . . ]; the only exception to this is in conversation analysis, as appropriate for the conventions used.

Emphasis
- Do not use italics, bolding, underlining, or ALL CAPITAL LETTERS for emphasis.
- Do not use italics for quotations (long or short).
- Do not use bolding except for level-1 headings, as appropriate (see below).

General formatting
- Do not add any special formatting to the document, such as increased line space before and/or after headings.

Headings
- Do not follow APA guidelines for headings; format your headings only as described in these QHR Guidelines.
- Do not use any headings (such as Introduction or Background) at the beginning of the manuscript.

Line spacing
- Do not create double spacing with hard returns (by striking the “enter” key twice).
- Do not leave blank lines between paragraphs (with the exceptions of after block quotes/excerpts, bulleted or numbered lists, or sections of conversation analysis; see below).

Margins and indentations
- Do not use full justification for any portion of your manuscript. The text at the right-hand margin should be uneven (irregular).
- Do not make indentations using tabs, or by using two, .25” indentations to achieve a .5-inch indentation.
- Do not change margins to create indentations.
- Do not change the margins for block quotes (margins should remain at 1” on all sides).

Quotations
- Do not use any quotation marks for block quotes unless there is a separate, shorter quote contained within the larger quote; in such a case, use double quotation marks (e.g., Xxxxxx, “Yyyy,” xxxxx.) only for the “inner” quote.

Seriation
- Do not use numbers of any type for in-text seriation; use only (a), (b), (c), and so forth.

“REVIEW” YOUR MANUSCRIPT

One common reason for “revise” decisions is that authors are sometimes so immersed in their data and findings that they lose track of

- whether the information presented contributes new knowledge
- whether the appropriate method and design have been used
- whether ethical standards have been met
- whether the information is presented in a complete, concise, and logical manner, with attention to writing style, and
- what the reader needs/wants to know (remember that QHR readers have expertise in diverse areas, and therefore many will not be familiar with concepts and terminology common to your research area)

Before submission, we recommend an informal peer review of your article, using the criteria shown on page 55.

PRIOR TO SUBMISSION

- Make sure your entire manuscript is prepared in accordance with these Guidelines in every respect.
Have your manuscript *professionally* edited by an expert in the English language. This is especially important if English is not your first language. Remember to inform your editor of the need to use U.S.-English spelling, and provide him or her with a copy of these Guidelines.

Proofread your manuscript aloud; doing so will help you identify awkward phrasing, run-on sentences, incomplete sentences, improper punctuation, missing text, and much more. We recommend that the corresponding author and all coauthors proofread the entire manuscript (including abstract and references) from a paper copy rather than a computer screen.

Your keywords are words related to the article topics that readers or researchers could search on to find your published article. They are also used to assist *QHR* in selecting appropriate reviewers for your manuscript during the review process.

Keywords should follow on the same page as the abstract. Leave a blank, double-spaced line between the abstract and the keywords (see the sample manuscripts beginning on page 35).

Include keywords *selected only from the QHR Keyword List*, below. List them exactly as they are shown in the keyword list, in lowercase letters (except for proper names), horizontally across the page, *in the order in which they appear on the keyword list*. Try to select at least five keywords. Use the most specific keywords possible from the list provided.

Individual keywords should be separated by semicolons; note that some keywords are actually two or more words, and might include commas. Do not capitalize the first keyword unless it is a proper name (i.e., Africa), and do not add a period (full stop) at the end of the keywords.

You may request that new keywords be added to the list, but the words should be *general* in nature, and not specific to a narrow topic. New keywords will be added at the editor’s discretion.

**QHR Keyword List**

*Note: We recommend reading the entire list to identify the most relevant keywords.*

*Remember that the keywords might not be listed exactly the way you think of them (the specific words and the order of words might be different).*

Aboriginal people, Australia  
Aboriginal people, North America  
abortion  
abuse, child  
abuse, domestic  
abuse, emotional  
abuse, physical  
abuse, sexual  
adoption / substance use  
adherence / compliance  
adolescents / youth  
adolescents / youth, at-risk  
adolescents, pregnancy / parenting  
Africa  
Africa, North  
Africa, South  
Africa, sub-Saharan  
Africa, West  
African Americans  
aging  
alcohol / alcoholism  
altruism  
Alzheimer’s disease  
America, Central  
America, North  
America, South  
anesthesia  
animal-human interactions  
anorexia / bulimia  
anthropology  
art  
arthritis  
Asia  
Asia, Central  
Asia, Eastern  
Asia, South / Southeast  
Asian people / cultures  
asthma  
attachment / bonding  
attention-deficit hyperactivity disorder (ADHD)  
autism  
avtoethnography  
behavior change  
bereavement / grief
biographical analysis
depression
descriptive methods
developing countries
diabetes
diaries / journals
dignity
dimensional analysis
disability / disabled persons
disability, developmental
disability, learning
discharge planning
discipline / subdiscipline
disclosure
disfigurement
Down syndrome
dramaturgical analysis
eating disorders
education, patient
education, professional
embodiment / bodily experiences
emergency care
emotions / emotion work
empathy
end-of-life issues
enduring
environment
epidemiology
epilepsy
epistemology
ethics / moral perspectives
ethnicity
ethnography
ethnomethodology
ethnoscience
ethnosemantics
ethology
Europe, Eastern
Europe / Europeans
Europe, Western
euthanasia
event analysis
evidence-based practice
exercise / physical activity
exercise / physical activity, older people
experiential methods
exploratory methods
falls / falling
families
families, caregiving
families, high-risk
fathers, fathering
fatigue / exhaustion
feminism
fertility / infertility
fibromyalgia
focus groups
Gadamer
gays and lesbians
gender
genetics
geriatrics
Giorgi
grounded theory
group interaction
healing
health and well-being
health behavior
health care
health care administration
health care disparities
health care professionals
health care screening
health care, access to
health care, alternative and complementary
health care, acute / critical
health care, culture of
health care, economics of
health care, international
health care, interprofessional
health care, long-term
health care, managed
health care primary
health care, remote / rural
health care, teamwork
health care, transcultural
health care, users’ experiences
health care, work environment
health informatics
health information seeking
health insurance
health outcomes
health policy / policy analysis
health promotion
health seeking
health, determinants of
hearing / deafness
heart health
Heidegger
hepatitis C
hereditary diseases
hermeneutics
heuristic techniques
HIV/AIDS
HIV/AIDS prevention
holistic care
homelessness
hope
human resources
humanistic perspectives
humor
Huntington’s disease
Husserl
hypertension
illness and disease
illness and disease, chronic
illness and disease, experiences
illness and disease, infectious
illness and disease, life-threatening / terminal
illness and disease, prevention
illness and disease, progressive
illness and disease, social construction
immigrants / migrants
immunization
induction
infants
infants, high-risk
instrument development
intensive care unit (ICU)
Internet
interpretative phenomenological analysis (IPA)
interpretive description
interpretive methods
intervention programs
interviews
interviews, electronic
interviews, semistructured
interviews, unstructured
knowledge construction
knowledge transfer
knowledge utilization
language / linguistics
Latino / Hispanic people
lay concepts and practices
legal issues
leukemia
library methods
life history
literature
lived body
lived experience
longitudinal studies
marginalized populations
masculinity
medical record
medicalization
medication
medicine
medicine, traditional / folk
memory
men’s health
menopause
mental health and illness
mental health and illness, children / adolescents
mental health nursing
mentoring
Merleau-Ponty
meta-analysis
meta-ethnography
metasynthesis
Mexican Americans
Mexico, Mexicans
Middle East, Middle Eastern people
midlife
midwifery
minorities
model building
mothers, mothering
motivation
multiculturalism
multiple sclerosis (MS)
social work  transplantation
sociology  transsexuals
sorrow  trauma
spinal cord injury  triangulation
statistics  trust
stigma  tuberculosis (TB)
stories / storytelling  uncertainty
stress / distress  urban issues
stroke  validity
suffering  van Manen
suicide  violence
surgery  violence, against women
surgical enhancement  violence, domestic
surveys / questionnaires  vision
survivorship  visual methods
symbolic interactionism  vulnerable populations
symptom management  war, victims of
systematic reviews  weight management
teaching / learning strategies  women’s health
technology  women’s health, midlife
technology, assistive  women’s issues
technology, institutional  workplace
technology, medical  wound care
technology, use in research  young adults
theory development
translation

MANUSCRIPT PREPARATION

ELEMENTS OF A MANUSCRIPT

Note: Some instructions differ for accepted manuscripts; please refer to page 28.

The following elements are required for each manuscript, and should be compiled in the following order:

Title page  Submit the title page as a separate document.
Abstract  The abstract is placed on page 1 of the main document.
Keywords  Place the keywords below the abstract, on the same page. Leave a (double-spaced) blank line between the abstract and the keywords.
Main manuscript  The main text of the manuscript begins on page 2 of the main document.
References  References begin on a new page, after the end of the manuscript text, or after the notes, if any (do not submit references in a separate document).

The following elements are optional, and may be included in your submission:

Notes  Place notes (also known as endnotes or footnotes) after the main text, before the first page of references.
Tables  Place tables, one per page, at the end of the main manuscript document, after the references (do not submit tables as separate documents).
Figures  Submit each figure in a separate document, in order, by number.
Appendices  Appendices are published only at the editor’s discretion. Place any appendices after the reference list, and before any tables (place them before the bios in accepted manuscripts).

June 14, 2011
PREPARATION OF MANUSCRIPT ELEMENTS

A maximum of four (4) types of documents should be submitted: (a) title page; (b) main manuscript; (c) figures (if any); and (d) permissions (if needed). Despite what the online submission system (ScholarOne Manuscripts / SageTrack) might allow, do not submit such elements as abstracts, references, and tables in separate documents. Be sure to refer to the sample manuscripts, beginning on page 35.

TITLE PAGE

The title “page” may be longer than one page. To maintain author anonymity during peer review, it is submitted as a separate document. Title page information should not be included in the main manuscript document. Do not format a running header. The title page should include the following, in this order:

Article title A title should convey, as clearly and succinctly as possible, the main idea, focus, or content of a manuscript. It should be clear in meaning even when standing alone.

Make your title 10 to 12 words (or fewer) in length; avoid long, “wordy” titles. Avoid titles with colons or quotations unless they are necessary to convey an important concept or idea in the article.

Type your title in Title Case; this means you should:
* capitalize the (first letter of) the first word
* capitalize all important words
* capitalize all words that have four (4) or more letters
* capitalize the first word after a colon (:), period (.), or em dash (—)

Author names List the name (not just initials) of each author, without credentials, in order, horizontally across the page.

If there are two authors, list them as follows: Janice M. Morse and Author Two
If there are three or more authors, list them as follows: Janice M. Morse, Author N. Two, Writer Three, and Fourth Author (and so forth)

After each name (or after the comma following a name, if applicable), use a superscript number to link that particular author with his or her primary affiliation (see the section on author affiliations, below).

Author affiliations Using the same superscript numbers as used with the authors’ names (see above), list only the primary affiliation of each author, not multiple affiliations (see the sample manuscripts).

Spell out all city, state, and country names (exception: use USA instead of United States). Spell out any organization or institution names (for example, University of Utah instead of U of UT, or World Health Organization instead of WHO).

Corresponding author information Use only the following format for the corresponding author information, and do not include any information that is not listed below. List information only for the individual who should be contacted by readers after (if) the article is published. Note that this should be a mailing/postal address. Example:

Janice M. Morse, University of Utah College of Nursing, 10 S. 2000 E., Salt Lake City, UT 84112-5880, USA
Email: QHR-Editor@nurs.utah.edu

Author’s / Authors’ Note This is optional. This is the place to mention, perhaps, that portions of the article were presented at a professional meeting, or other information of that sort.

Acknowledgments This is optional. The section is limited to two (2) or three (3) brief sentences. Overlong acknowledgments will be reduced at the copyeditor’s discretion. Do not include long descriptions of persons being acknowledged, and do not include roles, titles, or credentials.
Avoid phrases such as We wish to thank, We would like to thank, and We want to thank; just use a simple, We thank, or We acknowledge.

**Declaration of conflicting interests**

You must use one of the following statements, in the exact words shown below.

*If you have no conflicts of interest (or potential conflicts of interest):*

The author(s) declared no conflicts of interest with respect to the authorship and/or publication of this article.

*If you have conflicts of interest:*

The author(s) declared a potential conflict of interest as follows: [Then, in sentence form, list all specific author relationships with organizations and/or products that were declared].

**Funding**

You must use one of the following statements, in the exact words shown below.

*If you did not have financial support:*

The author(s) received no financial support for the research and/or authorship of this article.

*If you did have financial support:*

The author(s) disclosed receipt of the following financial support for the research and/or authorship of this article: [Then list, in sentence form, all entities/organizations that funded the research and/or authorship].

**Bios**

Bios are simple and concise, 1-sentence statements about each author. Long bios will be reduced by the copyeditor. In this space you may include department or division names, and secondary affiliations (if any). Use only the format shown below for your bios. Note that primary credentials (the most important only, with a limit of three per person; QHR does not publish long credential strings) and current positions (or affiliations or professional pursuits) are required.

**Janice M. Morse**, PhD, FAAN, is a professor and presidential endowed chair at the University of Utah College of Nursing in Salt Lake City, Utah, USA.

[Template: Name, bolded, credentials, role or title, affiliation (here you may include department, school, division, and so forth), city, state or province (if any), country.]

**ABSTRACT AND KEYWORDS**

The abstract should be placed at the top of page 1 of the main manuscript document. It should be a single paragraph, no more than 150 words in length, and briefly describe your article. It should not contain headings or citations, and should not be divided into sections. Place your keywords below the abstract, on the same page (see "Keywords," above).

Double space the entire abstract page (including the keywords). Briefly state the purpose of your research, the main findings, and your primary conclusions. Make sure the abstract is written in the first-person, active voice.

**MAIN MANUSCRIPT**

Note that the sample manuscripts beginning on page 35 are abbreviated for illustration purposes, and might not contain all optional elements that could be included in an actual manuscript. The sample articles contain all four heading levels.

The main text of the manuscript begins at the top of page 2 of the document, immediately after the abstract page. Write your article in the first-person, active voice.

The main text of the manuscript should be broken into appropriate sections by the use of section headings. Sections should flow in a logical sequence, and include, at a minimum, Methods, Results, and Discussion (these are all level-1 headings); other level-1 headings and subheadings may be used at the author’s discretion. The author may choose to use different names for the three main sections, but the basic content should be that which would appropriately fall under the headings of Methods, Results, and Discussion.
There are very specific requirements for the preparation of in-text citations; refer to the APA Publication Manual, 6th edition, for details. Every in-text citation should have a corresponding reference in the reference list—no exceptions.

During the review process, author citations should include only the word Author and the year: (Author, 2008). If and when the manuscript is accepted for publication, the missing information can be restored.

Double space the entire manuscript document, except for text contained in figures. Use only U.S.-English spelling (except in the references, as appropriate, and for direct quotations from published written sources). Use U.S.-English translations of non-English quotations or excerpts. Use a minimum of two (2) heading levels.

Attend to copyright regulations and permission requirements (required). Submit, at the time of manuscript submission, written permission for the use of any names, photographs, or copyrighted tables, figures, and/or text; written permission must come from the person(s) depicted in the photographs, or in the case of copyrighted work, from the copyright holder (which is not necessarily the author or the journal in which it is published; see page 7).

REFERENCES

Note: Proper formatting of the reference list is the responsibility of the author, NOT journal personnel.

The reference list (also known as a bibliography) should include complete references for the sources used in the preparation of your manuscript. Every reference must be cited in the text.

The reference list should begin on a separate page (not in a separate document) following the last page of manuscript text (or after the notes, if any). Each type of reference (journal article, book, chapter in edited book, newspaper, online reference, and so forth) must be formatted in accordance with the precise guidelines contained in APA, 6th edition.

Elements such as listing order, spelling, punctuation, spacing, capitalization, and the use of italics or Roman (regular) font are as important as the content of the reference. Note that if an author has two or more initials, there should be spaces between the initials; incorrect = X.Y.Z.; correct = X. Y. Z.

References should be listed in hanging paragraph format (with indentations at ½ inch), in alphabetical order by the last name of the first author; additional considerations might apply (see APA). The hanging paragraphs should be created by using Word’s Format > Paragraph feature.

During the review process, author references in the reference list should include only the word "Author" and the year: Author. (2008). To prevent author identification during the review process, do not include the article title, journal name, or any other part of the reference. Do not place these references in alphabetical order in the reference list; place them at the very beginning or very end of the list. If and when the manuscript is accepted for publication, the missing information can be restored and properly placed.

Avoid the use of unnecessary references and lengthy reference lists. Extensive bibliographies will not be published; articles should include only the “essential” or key references. If the author wishes to offer a secondary reference list (for example, references used in meta-analysis), it should be so stated in a footnote, and made available to readers by contacting the author directly. Do not include such a list in the manuscript document, but it may be submitted separately for purposes of review.

Use only the 6th edition of the Publication Manual of the American Psychological Association (APA) as your source of instruction for references (this is critically important). Translate non-English titles into English (see APA for instruction on how to do this). Reference and cite all other studies mentioned in the article. Test all Internet URLs (Web addresses) immediately before submission to ensure that they are accurate, and that the sites are still accessible; do this prior to submission of all revisions and accepted manuscripts, as well.

APPENDICES

Appendices are not encouraged, and are published only at the editor’s discretion. If included, appendices should be placed in the main manuscript document following the reference list, and before any tables (place them before the bios in an accepted manuscript). Appendices must be referred to in the text.
**WHAT YOU SHOULD NOT DO**

**Title page**
- Do not type your title in ALL CAPITAL letters (this is especially important when entering the article title in the ScholarOne Manuscripts / SageTrack system).
- Do not place a period (full stop) at the end of your title.
- Do not include unnecessary words, such as *A Qualitative Study*, *A Doctoral Student’s Investigation of*, *An Ethnographic Study*, and so forth.
- Do not list secondary or additional author affiliations (departments, divisions, hospital units, and so forth).
- Do not use abbreviations (except USA).
- Do not include department or division names, or secondary unit names.

**Abstract**
- Do not include the manuscript title on the abstract page.
- Do not indent the first line of the abstract.
- Do not include citations.
- Do not show the word count.
- Do not repeat text from the manuscript in the abstract.

**Main document**
- Do not include the manuscript title.
- Do not include any author-identifying information.
- Do not include participant identifiers (name, pseudonym, age, and so forth) except to identify a particular category of respondent (e.g., males age 18 to 24; community professional; psychologist; and so forth), and even then, include identifiers only when necessary for reader understanding.
- Do not include names of specific study sites (hospitals, organizations, small towns or villages).
- Do not use any headings (such as “Introduction” or “Background”) at the beginning of the manuscript.

**References**
- Do not format the hanging paragraphs with hard returns (“enter”) and tabs.
- Do not submit the reference list as a separate document (except for lists such as meta-analysis references, as noted above).

---

**FINAL CHECKLIST FOR SUBMISSION**

**Goal:** To submit the perfect manuscript. This checklist is intended to facilitate the swift internal review of your manuscript prior to submission.

**General Manuscript Preparation**

Refer to the instructions contained in the *QHR Manuscript Guidelines*. Review the section addressing *QHR* style, beginning on page 8.

**Avoid Common Problems:**
- Refer to your article as an *article*, not as a paper or a study.
- Avoid anthropomorphism. Neither your study nor your article conducted the research: you did. Neither your study nor your article considered, chose, utilized, explored, selected, or took any other type of action: you did.

**Checklist:**
- Consistently use the first-person, active voice in your writing.
- Be accurate and consistent with verb tense: things that happened, were written, or were said in the past should be written about in the past tense.
Submit the title page as a separate document.

Obtain (and submit) any needed permissions for use of copyrighted work and/or for the use of photographs/images.

Obtain an informal peer review of your manuscript prior to submission (see the review criteria on page 55).

Have your manuscript professionally edited prior to submission. If English is not your first language, make certain your editor is an expert in the English language.

**QUOTATIONS**

Read the instructions regarding quotations on page 14 of the *QHR Manuscript Guidelines*.

**AVOID COMMON PROBLEMS:**

- Participant identifiers and/or codes included with quotations pose a potential threat to participant confidentiality; do not use them. Even pseudonyms should be used with caution, especially if it is possible for the reader to “track” multiple comments presented from a particular participant.

- Ellipses/ellipsis points ( . . . ) are to be used only to represent deleted words or phrases, and not pauses in speech.

**CHECKLIST:**

- Set quotations of fewer than 40 words within regular sentences. Set quotations of 40 or more words as block quotes. (Use Word’s “Word Count” feature.)

- Indent block quotes by ½ inch from the left margin only. (Use Word’s “Format > Paragraph” feature to create the indentation.)

- Type your quotations in 12-point Times New Roman font, double spaced. Do not use italics.

- Cite and reference all quotations taken from sources other than research participants, and include page numbers in the citations.

- If you add words of explanation or comment within quotations, place those words in [brackets] rather than (parentheses).

- Properly capitalize and punctuate all participant quotations.

**REFERENCES & CITATIONS**

See page 24 in the *QHR Manuscript Guidelines*. Follow the sixth edition of the *APA Publication Manual*.

**AVOID COMMON PROBLEMS:**

- APA has stipulated a particular format for each specific reference type; be sure to use the correct format. Note that not all types of periodicals are referenced in the same manner as journal articles.

- References and citations should be prepared with exactness and attention to detail. The order of listing, spelling, punctuation, spacing, capitalization, and use of italic or Roman font are all important.

**CHECKLIST:**

- Spell out all journal names, and provide complete page numbers (e.g., 172-185 rather than 172-85).

- “Blind” your personal (author) references and citations as noted in the *Guidelines*.

- Double check the spelling of all reference author names, and ensure that both spelling and years of publication are consistent between the reference list and the in-text citations.

- Provide English translations for all non-English titles (retain the original titles).
Format your references in hanging-paragraph style and double line spacing. Indent the “hanging” text by ½ inch, using Word’s “Format > Paragraph” feature.

**TABLES**

**GOAL:** To organize and present relevant data that would be too cumbersome or complex to write into the text. Our standard is space. If your material can be more efficiently presented as text, do not make a table. A table must not duplicate material already appearing in the text.

Read the instructions for table preparation on page 29 of the *QHR Manuscript Guidelines*. Place each table on a separate page at the end of your manuscript document.

**AVOID COMMON PROBLEMS:**
- The typesetting process removes all bullets from tables (whether numerals, letters, or dingbats); do not use them.
- The use of underlining, all uppercase (capital) letters, and italics can make a table look busy and cluttered, and can obscure important data. Use these features sparingly or not at all. Use bold font sparingly.

**CHECKLIST:**
- To maintain anonymity, present participant characteristics in aggregate (group) form, and refrain from listing individual participant characteristics.
- Make sure your table has a minimum of two (2) columns, a minimum of two (2) rows, and a clear and concise heading for every column. Double space the table.
- Create your table in “portrait” orientation on the page, within the regular 1-inch margins of the document.
- Give your table a clear, descriptive, and concise title.
- Place individual data items or grouped data in separate rows of the table, rather than placing multiple items in a single row.

**FIGURES**

**GOAL:** To create useful and coherent figures that clarify complex concepts or accurately illustrate models and/or processes.

See the instructions for preparing figures on page 31 of the *QHR Manuscript Guidelines*. Make your figure simple, clear, and easy to read and understand.

**AVOID COMMON PROBLEMS:**
- Put your efforts into presenting clear, meaningful data rather than “fancy” or artistic creations. Achieving simplicity, accuracy, and clarity should be your goals.
- Do not use shading, color, or bolded font.
- Too many lines and arrows, and especially lines and arrows that cross each other or cross text boxes, can lead to confusion and make a “muddle” of a figure, obscuring rather than revealing intended meaning. Do not use “heavy” or “bolded” lines and arrows.

**CHECKLIST:**
- Prepare and submit each figure in a separate document.
- Create your figure to be read from left to right and from top to bottom.
- Arrange text boxes in an orderly fashion, making them no larger than necessary to contain your text.
- Make your lines and arrows the proper length, so their beginnings and endings join the cells and clearly indicate direction.
- Use single line spacing for the text, and place the text in a horizontal orientation so it is not necessary to turn the document to read the figure.
☐ Give your figure a clear and concise title or legend. Include any notes after the title or legend rather than placing them below the figure.

☐ If using a participant’s artwork, be sure the lines are sufficiently distinct and dark enough to reproduce well if printed in the journal.

---

**INSTRUCTIONS FOR ACCEPTED MANUSCRIPTS**

If your manuscript has been accepted pending minor revision, the instructions for placement of certain manuscript elements differ from those for manuscripts under review. See the sample manuscript beginning on page 42. When preparing your final manuscript, compile and submit the various manuscript elements in the following order:

1. **TITLE PAGE**  
   *Required*  
   Insert your title page at the very beginning of your manuscript, before the abstract page; *do not submit it as a separate document*. Move other elements from the title page to other places, as instructed below, leaving only the following on the title page (in this order):
   - Article title
   - Author names
   - Author affiliations (Note: List *primary* affiliation only; e.g., university)
   - Corresponding author information

2. **ABSTRACT & KEYWORDS**  
   *Required* except for book reviews, letters to the editor, and guest editorials  
   Start the abstract at the top of the page after the title page. Leave a blank, double-spaced line between the end of the abstract and the beginning of the keywords.

3. **MAIN MANUSCRIPT TEXT**  
   *Required*  
   Start the main manuscript text at the top of the page after the abstract and keywords page.

4. **AUTHOR’S/AUTHORS’ NOTE**  
   *Optional*  
   At the end of the manuscript text, simply hit “enter” (or “return”), and begin the author’s/authors’ note (if any), with the heading and text on separate lines.

5. **ACKNOWLEDGMENTS**  
   *Optional*  
   At the end of the author’s note (or the end of the manuscript text, if there is no author’s note), hit “enter” and begin the acknowledgments (if any), with heading and text on separate lines.

6. **DECLARATION OF CONFLICTING INTERESTS**  
   *Required*  
   At the end of the acknowledgments (or author’s note, if there are no acknowledgments), hit “enter” and type the conflicting interests heading and appropriate statement (on separate lines). *Note:* You are required to use the specific language designated in the “Preparation of Manuscript Elements” section, beginning on page 22.

7. **FUNDING**  
   *Required*  
   At the end of the conflicting interests statement, hit “enter” and place the funding heading and appropriate statement on separate lines. *Note:* You are required to use the specific language designated in the “Preparation of Manuscript Elements” section, beginning on page 22.

8. **NOTES**  
   *Optional*  
   After the funding statement, hit “enter” and place the numbered notes on separate lines. Do not use superscript numbers in the notes list.
9. REFERENCES  

Required  
Begin the references on a new page (but not in a separate document).

10. APPENDICES  

Optional [published at the discretion of the editor]  
Begin each appendix on a separate page, with an appropriate appendix number, followed by the title of the appendix (required).

11. BIOS  

Required  
At the end of the references (or appendices, if any), hit “enter” and place the biographical statements, one per line.

12. TABLES  

Optional  
Place each table on a separate page after the bios. Be sure to place your tables in the main manuscript document, and not in separate documents.

13. FIGURES  

Optional  
Figures are to be submitted in separate documents (one figure per document), and formatted as describe in the “Figures’ section, page 31. Include the figure number in the document (file) name (i.e., Figure 1.doc).

Note: QHR personnel neither create nor make significant revisions to tables; this is the responsibility of the author.

Tables organize relevant, essential data that would be too awkward or too lengthy to include in the text, and should be used only to provide data not already included in the text. For example, grouped participant demographics take less space presented in a descriptive paragraph than they do as a table.

Tables are to be accompanied by both their number (Table 1, Table 2, and so forth) and their title (required).

Tables and table placement are mentioned in the text, but the tables themselves are placed at the very end of the main manuscript document. The author should designate placement of each table within the manuscript by entering (flush left, on a separate line between paragraphs), INSERT TABLE 1 ABOUT HERE. Table callouts should be placed following the paragraph in which they are first mentioned.

Create the table the way it should appear when published, then double space all text, including column headers and notes.

Use Gill Sans font style for table numbers, titles, content, and any explanatory notes. Use 12-point font for the table number and name, and use 8-point font for table content and explanatory notes.

“Hide” all vertical lines and all horizontal lines except the following: top line of table, bottom line of table, and line below the main column headers. Multiple tables within the same manuscript should be similar in appearance and design. (See the sample table, below.)

Considerations:

- Make sure that what you are trying to create actually is a table; all tables must have column headings, at least two (2) columns, and at least two (2) rows. Most simple lists do not qualify as tables.
- You must actually create a table, even though most lines will be hidden.
- Put each table on a separate page (not in a separate document).
- Use only portrait orientation for your tables.
- Include only necessary data.
- Ensure that all abbreviations are explained in the notes.
- Ensure that the table is clear and comprehensible even without the surrounding article text (it should be able to “stand alone”).
- Make your table titles concise and descriptive.
- Keep your table as small as possible; use only the space necessary to contain your data. To fit within a single column of the journal, the table should be no wider than 3½ inches; to fit across both columns it should be no wider than 6 inches. Narrow the table columns to eliminate unused “white” space.
- Place explanations, clarifications, citations and source notes, symbol and abbreviation identification, and other “nondata” information in notes below the table.

**What you should NOT do**

- Do not use shading or color, or overuse bolding and/or italics (which can detract from a table, making it look “busy” without enhancing it in any way); do not use “heavy” or bolded lines.
- Do not list participants individually; instead, present group characteristics.
- Do not set tables in landscape orientation.
- Do not use bullets or numbered lists in tables.
- Do not make simple lists into tables; instead, place the lists in the manuscript text.

Sample table:

**Table 1. Name of the Table, Bolded, in Title Case**

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Secondary line of data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
</tbody>
</table>

*a Place notes here  
b Second note*
**Note:** QHR personnel neither create nor make significant revisions to figures; this is the responsibility of the author.

Like tables, figures should be used *sparingly*, and only when it is *necessary* to clarify complex relationships or concepts.

Use Gill Sans font for the figure number, title, text, and notes (if any). Single space all text contained within a figure (but not the figure number, figure title/caption, and notes, which should be double spaced). Figure placement should be mentioned in the manuscript text, but each figure *is to be submitted in a separate document*, with the figure number and figure title on the first page, followed by the figure itself on the second page. Figure titles/legends should be *concise* and *descriptive*.

The author should designate placement of each figure within the manuscript by entering (on a separate line between paragraphs) INSERT FIGURE 1 ABOUT HERE. Figure callouts should be placed following the paragraph in which they are *first* mentioned.

**Note:** Regular Word.doc documents are *strongly preferred* over .jpg or other document types, and are easier to revise, if necessary.

See APA for requirements regarding the use or adaptation of copyrighted (previously published) material.

**CONSIDERATIONS:**

- In the published journal, photographs and other images are referred to as “figures.”
- Use only Gill Sans font for figure numbers, titles, text, and notes (if any).
- Put each figure in a separate document.
- Use only 8-point font for figure text and notes.
- Make sure your figure is created to be read from *left to right*, from *top to bottom*.
- Use sufficient space between figure elements to ensure clarity, but eliminate unnecessary space.
- Make sure that hand-drawn figures (such as participant artwork) are dark enough to reproduce clearly when published.
- Use bolding and italics *sparingly*, and underlining only if absolutely necessary.
- Place your figure number and title/legend on the first page of the figure document (use Gill Sans 12-point font, double spaced).
- Place the figure itself on the second page of the figure document.
- Make sure your figures have “crisp,” clean lines and text. “Fuzzy” figures are not acceptable, and scanned figures are generally fuzzy.
- *Keep figures simple,* with as few lines, boxes, and arrows as possible; use plain arrows and solid, nonbolded lines. The style of the various elements of your figure must be consistent. Be careful about spacing and alignment of elements, including beginnings and endings of lines and arrows.
- Be aware that QHR does not publish in color; hand-drawn artwork and all photographs will be published in black and white only.

**WHAT YOU SHOULD NOT DO**

- Do not double space text within figures.
- Do not use shading or color.
- Do not place your figure inside an invisible “box” or “frame”; in other words, do not save the figure as a single item; save it as a collection of discrete elements, each of which can be corrected if necessary.
- Do not include your figures in the main manuscript document.
Sample figure, page 1 of figure document:

Figure 1. Name of figure here, in sentence case

Sample figure, page 2 of figure document:
MANUSCRIPT PREPARATION

See the sample book review beginning on page 49. In all essential ways, document setup for book reviews is the same as for regular article manuscripts, except that

1. fewer manuscript elements are needed; and
2. the manuscript elements are compiled in a different order.

Compile your book review as follows, in this order:

- **Book Information**
  - Use Gill Sans font for this section
  - Line 1: Name of book author(s) or editor(s)
  - Line 2: Name of book, in italics, in title case
  - Line 3: City and state or city and country of publication, and the name of the publisher
  - Line 4: Year of publication. Number of pages. List price. ISBN number

- **Reviewer Information (the person who wrote the review)**
  - Use Gill Sans font for this section.
  - Reviewed by: (in bolded font), followed by the reviewer’s name, then the primary affiliation organization (e.g., university) and country, in italics

- **Review Text**
  - Use Times New Roman font for this section.
  - Do not indent the first line of the opening paragraph.
  - Indent the first line of all subsequent paragraphs by .5 inches from the left margin.

- **References (if any)**
  - Put the References heading in Gill Sans bolded font.
  - Format the reference list exactly as you would for an article, in Times New Roman font and APA style (6th edition).

LETTER TO THE EDITOR

MANUSCRIPT PREPARATION

In all essential ways, document setup for a letter to the editor is the same as for regular article manuscripts, except that fewer elements are needed.

- Letters to the editor must have a title.
- The following elements are *not* needed in a letter to the editor:
  - Abstract
  - Keywords
  - Headings
  - Declaration of Conflicting Interests
  - Funding statement
- Format references, if any, in the normal manner.
- All other formatting rules that apply to article manuscripts apply to letters to the editor.
NOTE: Guest editorials are published by invitation only.
Do not submit unsolicited editorials.

MANUSCRIPT PREPARATION

In all essential ways, document setup for editorials is the same as for regular article manuscripts, except that fewer manuscript elements are needed.

Compile your guest editorial as follows, in this order:

▪ Line 1, in Gill Sans font: editorial title (required)
▪ Line 2, in Gill Sans font: name of the guest editor, with a superscript “1” linking to the corresponding author information
▪ Line 3, in Gill Sans font: superscript number “1”, followed by the guest editor’s primary affiliation (do not include department or division information here), city, state (or province; spelled out), country
▪ All in Gill Sans font, corresponding author information:
  ▪ Line 4: “Corresponding Author”, bolded, and followed by a colon
  ▪ Line 5: Name of guest editor, primary affiliation, department or division (if any), street address, city, state (or province; use abbreviations for this), postal code, country [this is your mailing address]
  ▪ Line 6: Email: with email address
▪ An abstract and keywords are not necessary
▪ Text of editorial
  ▪ Use Times New Roman font for this section
  ▪ Do not indent the first line of the opening paragraph
  ▪ Indent the first line of all subsequent paragraphs by .5 inches
  ▪ You may use headings if you wish, but they are not required
▪ References (if any)
  ▪ Put the References heading in Gill Sans bolded font
  ▪ Format the reference list exactly as you would for an article, in Times New Roman font and APA style
▪ A bio (biographical statement) is not required
Article Title, Set in Title Case

Janice M. Morse,¹ Author N. Two,² and Writer Three¹

¹University of Utah, Salt Lake City, Utah, USA
²ABC University, Any Town, Any State, Australia

Corresponding Author:

Janice M. Morse, University of Utah College of Nursing, 10 S. 2000 E., Salt Lake City, UT 84112, USA

Email: QHR-Editor@nurs.utah.edu

Authors’ Note

Portions of this article were presented at the 10th Annual Health Care Conference, August 1, 2009, in Salt Lake City, Utah.

Acknowledgments

We thank our research assistants, name, name, and name for their invaluable contributions to the study.

Declaration of Conflicting Interests

The authors declared no conflicts of interest with respect to the authorship and/or publication of this article.

Funding

The authors received no financial support for the research and/or authorship of this article.

Bios

Janice M. Morse, PhD, RN, FAAN, is a professor and presidential endowed chair at the University of Utah College of Nursing in Salt Lake City, Utah, USA.

Author N. Two, MD, is a professor in the Department of Health Research at ABC University in Any Town, Any State, Australia.

Writer Three, PhD, is an associate professor at the University of Utah College of Nursing in Salt Lake City, Utah, USA.
Abstract
Begin your abstract flush left at the top of the page, immediately below the abstract heading; do not indent the first line. The abstract may be up to 150 words in length. The entire abstract should be contained within a single paragraph. Do not add section headings or break the abstract into sections. Do not include citations in the abstract. Do not show the word count. Do not repeat the text of the main manuscript in the abstract.

Keywords
illness and disease; lived experience; pain; stress / distress; suffering

Begin the opening paragraph flush left at the top of the page. Do not indent the first line of the opening paragraph.

After the opening paragraph, indent the first line of all new paragraphs (those that do not follow headings) by .5 inches. Create this indentation by formatting the paragraph style (Format > Paragraph); do not indent the line with the tab key. Do not leave line breaks between paragraphs. Instead, continue with regular double spacing. Leave a blank line after every numbered or bulleted list:

1. Xxxxxxxxxxx xxxxx xxxx xxxxx xxxxx xxxxx xxxxx
2. Xxxxxxxxxxx xxx xxxxxxxxxxxxxxxx
3. X xxxxx xxxxxx xx xxxxxxxxx xxxxxxxxxxxxx xx

Note that this is a new paragraph, so the first line is indented.

Level-1 Heading
Level-1 headings are set flush left, bolded, in title case, and Gill Sans font. Begin the next paragraph immediately after the heading, and do not indent the first line of the first paragraph. XXXXX XXXXXXXXX xx XXXXXX XXXX.

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX (refer to the APA Publication Manual, 6th edition, for specific information on how in-text citations are to be prepared).

INSERT TABLE 1 ABOUT HERE

Level-2 Heading

Begin the next paragraph immediately after the heading. Level-2 headings are set flush left, italicized, in title case, and Gill Sans font. This is an abbreviated sample manuscript, and therefore it is not complete. In your manuscript, however, use two or more level-2 headings below a given level-1 heading, or use no level-2 headings; you may not use just one. XXXXXXXX XXXXXX x XXXXXXXX. ¹ XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX:

This is a sample block quote (also known as an excerpt). The entire quote should be indented by .5 inches (the first line is not indented further). Indent the quote by using Word’s Format > Paragraph function. Do not use tabs to prepare block quotes.² Do not indent from the right margin!

Interviewer (I): XXX XXXX XXXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX?

Participant (P): XXXX XXXX. XXXX XXXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX.

I: XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX?

P: XXXX. XXXX XXXX.
This is a continuation of the paragraph above, so the first line is not indented. 

Do not use quotation marks with excerpts, “Unless there is a quotation within a quotation.” Then be sure to use double quotation marks. The text of the block quote should be in the same font style and size as the regular manuscript, and should not be italicized. Leave a blank line after each block quote/excerpt. Leave a blank line between excerpts and/or sections of dialogue if you present two or more in a row, as shown here.

Level-3 heading. Try to avoid the use of level-3 headings if possible. Level-3 headings are set flush left, italicized, in sentence case, in Gill Sans font, and followed by a period. They follow immediately after the preceding paragraph, without additional line breaks. Note that the paragraph text begins immediately after the heading, on the same line. Do not use level-3 headings unless you have a total of four heading levels in your manuscript. Use two or more level-3 headings below a given level-2 heading, or use no level-3 headings; you may not use just one.

Level-1 Heading

Level-2 Heading

INSERT FIGURE 1 ABOUT HERE
Excerpt 1: Emilie [Sample of conversation analysis (without transcription symbols); note that all table lines are hidden.]

1 Interviewer (I): What happened after
2 that?
3 Emilie (E): Well, after that I
4 walked to the corner without my
5 friend, because he took too long
6 getting ready to go.
7 I: How did you feel walking there
8 by yourself?
9 E: I was a little bit nervous,
10 ‘cause I’m not used to going places
11 by myself.

Level-3 heading. Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
1. Text of first note. Do not format numbered bullets. Simply type the number, followed by a period and a space. You may include properly formatted citations in the notes, as appropriate.

2. Text of second note. Remember to include a corresponding superscript number in the text (after the ending punctuation, please) for each footnote.

3. Text of third note (and so forth). Do not use Roman numerals or letters for footnotes.

References

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented by .5 inch). Use Format > Paragraph rather than tabs to create the hanging paragraph format. doi:10.xxxxxxxx.xsss.xxxxxxxxx


Author, D. E., & First-Author, G. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references.

Author, F. G., & Writer, X.-Y. (year). The content of each type of reference (article, book, edited book, online document, and so forth) must be formatted in a very specific manner. Refer to the APA Publication Manual, 6th edition only, for specific instruction on this. Double space the reference list. Use the same font size and line spacing as the main text of the manuscript.

Author, E. F. (year). As much as possible, use recent, primary sources. Authors might be asked to shorten overlong reference lists.

Appendix A

Name of Appendix

Appendix text goes here. If your appendix is a table, it must be formatted according to the table guidelines contained in this document. Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx.
Table 1. Name of the Table, Bolded, in Title Case

<table>
<thead>
<tr>
<th>Column Heading Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Secondary line of data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
</tbody>
</table>

<sup>a</sup>Place notes here  
<sup>b</sup>Second note

Figure 1. Name of figure here, in sentence case
Note: To conserve space in the Guidelines, single horizontal lines in sample manuscripts represent page breaks; double horizontal lines represent the start of a separate document. DO NOT place horizontal lines in your manuscript.

Article Title, Set in Title Case

Janice M. Morse,1 Author N. Two,2 and Writer Three1

1University of Utah, Salt Lake City, Utah, USA
2ABC University, Any Town, Any State, Australia

Corresponding Author:

Janice M. Morse, University of Utah College of Nursing, 10 S. 2000 E., Salt Lake City, UT 84112, USA

Email: QHR-Editor@nurs.utah.edu

Abstract

Begin your abstract flush left at the top of the page, immediately below the abstract heading; do not indent the first line. The abstract may be up to 150 words in length. The entire abstract should be contained within a single paragraph. Do not add section headings or break the abstract into sections. Do not include citations in the abstract. Do not show the word count. Do not repeat the text of the main manuscript in the abstract.

Keywords

illness and disease; lived experience; pain; stress / distress; suffering

Begin the opening paragraph flush left at the top of the page. Do not indent the first line of the opening paragraph.

After the opening paragraph, indent the first line of all new paragraphs (those that do not follow headings) by .5 inches. Create this indentation by formatting the paragraph style (Format > Paragraph); do not indent the line
with the tab key. Do not leave line breaks between paragraphs. Instead, continue with regular double spacing. Leave a blank line after every numbered or bulleted list:

4. Xxxxxxxxxxxx xxxxx xxxxx xxxxx xxxxxxxxx xxxxx xxxxx
5. Xxxxxxxxxxxx xxx xxxxxxxxxxxxxxxxx
6. X xxxxx xxxxxxx xx xxxxxxxxx xxxxxxxxxxxxx xx

Note that this is a new paragraph, so the first line is indented. Xxxxxx xx x xxxxxxxxxxxxxxxxxxx. Xxxxx x xxxxxxx x xxxxxx xxxxxxxx xxxxx xxxxx xxxxxxxxx xxxxx xxxxx xxxxxxxxx xxxxx xxxxx x xxxxxx xxxxxxxxx xxxxx xxxxxxxxx xx

INSERT TABLE 1 ABOUT HERE

Level-1 Heading
Level-1 headings are set flush left, bolded, in title case, and Gill Sans font. Begin the next paragraph immediately after the heading, and do not indent the first line of the first paragraph. Xxxxxx xxxxxxxxx xx xxxxxx xxxx.

Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx. Xxxxxx xxxxxxxxx xxxxxx xxxxxxxxx xxxxxxxxx xxxxx xxxxxxxx xxxxxxxxxxxxxxxxx xx xxxxxxxx xxxxxxxxxxxxxx (citation, year). Xxxxxxxxxxxxxxxxxxx xx xxxx xxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxx.

Level-2 Heading
Begin the next paragraph immediately after the heading. Level-2 headings are set flush left, italicized, in title case, and Gill Sans font. This is an abbreviated sample manuscript, and therefore it is not complete. In your manuscript, however, use two or more level-2 headings below a given level-1 heading, or use no level-2 headings; you may not use just one. Xxxxxxxx xxxxxxx x xxxxxxx.¹ Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx xx xxxxxxxxx xxxxx xxxxx xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx xxxxxx xxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxx (citation, year). Xxxxxxxxxxxxxxxxxxx xx xxxx xxxxxxxxx xxxxxxxxxx xxxxxxxxxx xxxxxxxxxx xxxxxxxxxx xxxxxxxxxx xxxxxxxxxx.

Level-2 Heading
Xxxxxxxx xxxxxxxxxx xx. Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx x xxxxxxx xxxxxxxxx xx xxxxxxxxx xxxxxxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxx. Xxxxxxxx xxxxxxxxxxxxxxx xxx xx xxxxxx, Cited Author (year), xxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxx. Xxxxxxxx xxxxxxxxx xxxxxx xxx xx xxxxxxxxxx xxxxxxxxxxxxxxx xxxxxxxxxx x

43
This is a sample block quote (also known as an excerpt). The entire quote should be indented by .5 inches (the first line is not indented further). Indent the quote by using Word’s Format > Paragraph function. Do not use tabs to prepare block quotes. Do not indent from the right margin!

Interviewer (I): Xxx xxxxx xxxxxxx xx xxx xxxxxxxx xxxxxx?  
Participant (P): Xxxxxx xxxx. Xxxx xxxxxxx xxx xxx x xxxxxxxxx xxxxxx. Xxxxxxx xxxxxx xxxx xxx xxxxxxxxx xxx xxxxx x xxx xxxxxx xxxx.

I: Xxxxx xx xx xxxxxxxxx xxxxxxxx xxxx xxxxxxxxx xxx xxxxxx?  
P: Xxxxx. Xxxxx x xxxxxxx.

Do not use quotation marks with excerpts, “Unless there is a quotation within a quotation.” Then be sure to use double quotation marks. The text of the block quote should be in the same font style and size as the regular manuscript, and should not be italicized. Leave a blank line after each block quote/excerpt. Leave a blank line between excerpts and/or sections of dialogue if you present two or more in a row, as shown here.

This is a continuation of the paragraph above, so the first line is not indented. Xxxxxxxxxxxxxxxxxxxxxxxxxx. Xxxxxxxxxxxxxxxxxxxxxxxxx x xxxxxxxxxxxxx xxxxxxx xxx xxxxxx x xxxxxxxxx xxxxxxx xxx xx xxxxxxxxx xxx xxxxxx xxxxxxxxxxxxxx (see Appendix A). Xxx xxxxxxx xxxxxxxxxxxxxxxxxxxxxx xx xxxxx xxxxxxxx x xxxxxxxxxxxxxxx.

**Level-3 heading.** Try to avoid the use of level-3 headings if possible. Level-3 headings are set flush left, italicized, in sentence case, in Gill Sans font, and followed by a period. They follow immediately after the preceding paragraph, without additional line breaks. Note that the paragraph text begins immediately after the heading, on the same line. Do not use level-3 headings unless you have a total of four heading levels in your manuscript. Use two or more level-3 headings below a given level-2 heading, or use no level-3 headings; you may not use just one. Xxxxxxx xxxxxxx xxx xxxxxx. Xxxxxxxxxxxxx xxxxxxx xxxxxxx xxx xx xxxxxxxxx xxx xxxxxx xxx xx xxx xxxxx x  
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx.
Excerpt 1: Emilie [Sample of conversation analysis (without transcription symbols); note that all table lines are hidden.]

1  Interviewer (I): What happened after
2    that?
3  Emilie (E): Well, after that I
4    walked to the corner without my
5    friend, because he took too long
6    getting ready to go.
7  I: How did you feel walking there
8    by yourself?
9  E: I was a little bit nervous,
10  ‘cause I’m not used to going places
11  by myself.
Level-4 heading. Level-4 headings are indented by .5 inches, italicized, in sentence case, in Gill Sans font, and followed by a period. Note that the text of the first paragraph under this heading follows immediately after the heading, on the same line, rather than beginning on the next line. Use two or more level-4 headings below a given level-2 or level-3 heading, or use no level-4 headings; you may not use just one.

Notes
1. Text of first note. Do not format numbered bullets. Simply type the number, followed by a period and a space. You may include properly formatted citations in the notes, as appropriate.
2. Text of second note. Remember to include a corresponding superscript number in the text (after the ending punctuation, please) for each footnote.
3. Text of third note (and so forth). Do not use Roman numerals or letters for footnotes.

Authors' Note
Portions of this article were presented at the 10th Annual Research Conference in Salt Lake City, Utah, December, 2010.

Acknowledgments
We gratefully acknowledge the support of Name One, Name Two, and Name Three in assisting with research design.

Declaration of Conflicting Interests
The authors declared no conflicts of interest with respect to the authorship and/or publication of this article.

Funding
The authors received no financial support for the research and/or authorship of this article.

References
Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented by .5 inch). Use Format > Paragraph rather than tabs to create the hanging paragraph format. doi:10.xxxxxxxxx.xssss.xxxxxxxxx


Author, D. E., & First-Author, G. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references.

Author, F. G., & Writer, X.-Y. (year). The content of each type of reference (article, book, edited book, online document, and so forth) must be formatted in a very specific manner. Refer to the *APA Publication Manual*, 6th edition only, for specific instruction on this. Double space the reference list. Use the same font size and line spacing as the main text of the manuscript.

Author, E. F. (year). As much as possible, use recent, primary sources. Authors might be asked to shorten overlong reference lists.

*Note: If you do not have an appendix, place your bios here, immediately following the references.*

---

**Appendix A**

*Name of Appendix*

Appendix text goes here. If your appendix is a table, it must be formatted according to the table guidelines contained in this document. Xxxxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxx xxxxxxxxxxx xx xxxxxxxxxxxxxxx

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx...
**Table 1. Name of the Table, Bolded, in Title Case**

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data(^a)</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Secondary line of data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Data(^b)</td>
<td>Data</td>
<td>Data</td>
</tr>
</tbody>
</table>

\(^a\)Place notes here  
\(^b\)Second note

---

**Figure 1. Name of figure here, in sentence case**

- Text
- Text
- Text
Abraham Lincoln (Ed.)

Name of the Book

Springfield, IL: Log Cabin Press

2009. 275 pp. $29.00. ISBN 0YYYYYYYY

Reviewed by: Janice M. Morse, University of Utah, USA

Begin the first line of the first paragraph flush left, two lines below the reviewer information. Indent the first line of all other paragraphs.

Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
References

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented by .5 inches from the left margin). Use Format > Paragraph rather than tabs to create the hanging paragraph format. doi:10.xxxxx.xxxxxxxxxxxxxxx

Author, D. E. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references. Retrieved from http://www.xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

Author, F. G., & Writer, X. Y. (year). The content of each type of reference (article, book, edited book, online document, and so forth) must be formatted in a very specific manner. Refer to the APA Publication Manual, 6th edition only, for specific instruction on this. Double space the reference list. Use the same font size and style as the main text of the manuscript.
Article Title, Set in Title Case

Janice M. Morse¹

¹University of Utah, Salt Lake City, Utah, USA

Corresponding Author:

Janice M. Morse, University of Utah College of Nursing, 10 S. 2000 E., Salt Lake City, UT 84112, USA

Email: QHR-Editor@nurs.utah.edu

Begin the opening paragraph flush left, two lines below the corresponding author information. Do not indent the first line of the opening paragraph.

After the opening paragraph, indent the first line of all new paragraphs. Create this indentation by formatting the paragraph style (Format > Paragraph); do not indent the line with the tab key. Do not leave line breaks between paragraphs. Instead, continue with regular double spacing.

Sample Manuscripts
Letter to the Editor
References

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented by .5 inch). Use Format > Paragraph rather than tabs to create the hanging paragraph format. doi:10.xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx


Author, D. E., & First-Author, G. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references.
Title of Editorial

Janice M. Morse¹

¹University of Utah, Salt Lake City, Utah, USA

Corresponding Author:

Janice M. Morse, University of Utah College of Nursing, 10 S. 2000 E., Salt Lake City, UT 84112, USA

Email: QHR-Editor@nurs.utah.edu

Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx.

Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx.

Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx.

Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx.
Reference

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented .5 inch). Use Format > Paragraph rather than tabs to create the hanging paragraph format. doi:10.xxxxxxxxxxxxxxxxxxxxxx
**REVIEW CRITERIA**

- **Importance of submission**: What are the manuscript’s strengths? Is it significant? Does it contain new and unique information?
- **Theoretical evaluation**: Is the manuscript logical? Is the theory parsimonious? Complete? Useful?
- **Methodological assessment**: Inductive approach? Appropriate method and design? Is the sample appropriate and adequate? Are data saturated? Theoretical analysis? Linked with theory and/or praxis?
- **Adherence to ethical standards?**
- **Manuscript style and format**: Please evaluate writing style, organization, clarity, grammar, appropriate citations, etc. Is the manuscript unnecessarily long?
- **Other Comments**: Please give specific advice to the author(s) on how to improve the manuscript.

**REVIEW, DECISION, AND REVISION PROCESS**

**THE MAIN PLAYERS**

- Corresponding author
- Technical editor
- Editor (and possibly a section editor)
- Expert reviewers

**STEPS IN THE PROCESS**

1. The **corresponding author** submits a manuscript
2. The **technical editor** checks the manuscript documents for general acceptability (Word.doc)
3. The **editor** conducts an initial, abbreviated review of the manuscript; at this point the editor can make a decision to:
   a. Send the manuscript out for peer review;
   b. Assign the manuscript to a **section editor** to manage the peer-review process; or
   c. Reject the manuscript because it is not within QHR’s mandate, is unsuited to QHR’s readership, or is not methodologically strong.
4. The **technical editor** extends invitations for **qualified experts** to provide a formal review of the manuscript; this includes:
   a. Entering keywords from the manuscript into the QHR database of expert reviewers
   b. Selecting reviewers whose keywords (areas of expertise) most closely match the keywords (topic areas) of the manuscript
   c. Extending invitations to prospective reviewers by email
5. The **invited reviewers** can choose to accept the invitation, or may decline it based on a lack of time or opportunity to conduct the review, or because their expertise is not a good match for the main topic(s) of the manuscript.
6. If the **reviewer** accepts the assignment, the online review system, ScholarOne Manuscripts / SageTrack, automatically sends the reviewer, via email, instructions on how to access the manuscript and submit the review. If the reviewer declines the assignment, the **technical editor** repeats Step 4, above, until a sufficient number of reviewers have agreed to evaluate the manuscript (usually three reviewers). Depending on the time of year (because of vacations, holidays, breaks in academic schedules, and so forth), the number of qualified potential reviewers with expertise in the appropriate topic area, and the speed with which the invited reviewers respond to the invitation, this step in the process can take a significant amount of time.
7. The reviewers read through the manuscript (usually several times), and electronically submit their responses to the questions listed below. Although reviewers are asked to submit their evaluations within 30 days of accepting the assignment, circumstances might arise which preclude their meeting the deadline. No decisions can be made until the reviews are received.

8. When all reviews of a particular manuscript have been received, the technical editor provides them to the editor, along with the manuscript, for consideration and a decision.

9. Based on the reviews received, and the editor's own evaluation, the editor makes a decision on the manuscript. Possible decisions include:
   a. acceptance of the manuscript for publication
   b. provisional acceptance of the manuscript, pending specific revisions based on editor and/or reviewer comments, and specific formatting and content requirements of the journal
   c. an invitation to revise the manuscript in response to reviewer comments and suggestions, address formatting and content requirements of the journal, and resubmit it for further consideration
   d. rejection of the manuscript, possibly with recommendations for improving it in readiness for submission elsewhere

10. The technical editor sends the editor's decision and the reviewers' comments, via email, to the corresponding author. (Note: The decision will be sent as soon as it is possible to do so. Do not send requests for “quick” decisions because of pending performance, promotion, or tenure reviews, or because you are updating your curriculum vitae [CV].)

11. The corresponding author reviews the decision letter with any coauthors. If invited to submit a revision, either for publication or for further consideration, the author(s) can choose to accept or decline that invitation. If they accept, they revise the manuscript as instructed, and submit it.

12. The editor reviews the revised manuscript, and makes one of the following decisions:
   a. Accept the manuscript for publication
   b. Return the revision for peer review (usually with the original reviewers providing the new evaluation)
   c. Invite the author(s) to make further revisions, either with provisional acceptance for publication, or for further consideration
   d. Reject the manuscript

A note about the decision letter: If you receive an email decision letter indicating that your manuscript is “not suitable for publication in QHR”—even if suggestions are provided for improving the manuscript—your article has been rejected.

“Reject” decisions are sent only if, in the editor’s opinion, the manuscript cannot be adequately revised so as to make it suitable for publication in the journal. Therefore, please do not contact QHR with appeal requests unless you believe there has been a clear and significant misunderstanding about the content of your manuscript.

It is not necessary to respond to or acknowledge decision letters unless you have a question about the decision or the required revisions.

Any author is welcome to significantly revise a rejected manuscript and submit it as a new manuscript, receiving a new manuscript ID number. Such manuscripts will be considered and/or reviewed in the same manner as any other new manuscript.

13. The technical editor sends the decision to the corresponding author. If the manuscript is accepted, the technical editor places it in the production queue.

Reasons for “Revise” and “Reject” Decisions

Whether or not an author receives a “revise” or “reject” decision depends on

1. the nature of the reviews and the magnitude of the changes required
2. whether or not it is possible to correct the manuscript sufficiently to make it suitable for publication
3. how much *QHR* has recently published on a particular topic (or how much is currently queued for publication)

**TIMING OF PUBLICATION**

In a general sense, *QHR* publishes articles according to when they were accepted, not according to when they were first submitted. In other words, manuscripts accepted first are generally published first. Deviations from this general practice can and do occur, however, primarily because of (a) space restrictions within a particular issue, or (b) because certain articles are grouped and published together in special themed issues.

At any given time there are many accepted articles in the production queue. Therefore, it is unlikely that your accepted article will be published immediately after being accepted. It is not possible to know how many pages an article will need until the article is actually “set” by the typesetter. Many factors influence the length of a set article, including number of words, number of headings, number and length of paragraphs, use of tables and figures, and much more. Because the journal has a limited number of pages available for each volume, this sometimes causes individual articles to be “pulled” from their anticipated placement in a particular issue, and to be replaced by articles that best fit the number of pages available.

For these and many other production-related reasons, *it is not possible for QHR to accurately forecast a publication date for your article*. The production process is a long one, and articles are not published until at least 4 months after the edited version of the manuscript has been approved by the author. *Therefore, we appreciate your cooperation in refraining from making frequent inquiries about the publication date.*

**PRODUCTION**

Your manuscript will be edited to conform to *QHR* and Sage publication style and standards, and sent to you for your approval and correction. There will be a very short deadline for responding to any queries posed by the copyeditor (usually about 3 or 4 days), and it is critical that your response be clear, *complete*, and timely.

*The editing stage* is the time to make any *substantive* revisions to the manuscript; *do not wait for the proof*.

Following receipt of your response, the copyeditor will finalize your manuscript and submit the article to Sage Publications. Within a few weeks (usually about 2 to 3 weeks) you will receive a typeset proof of the article. Again, it is critical that you read the proof carefully and respond to Sage’s production editor by the deadline given. Clearly specify any needed corrections.

*The proof stage* is intended *only for minor corrections*. Do not ask the Sage Publications production editor to change corrections or revisions made at the editing stage. Requested changes that are contrary to *QHR* and Sage publication style will not be incorporated.
HOW TO SUBMIT A NEW MANUSCRIPT

Qualitative Health Research (QHR) uses an online review system that requires submitting your article through our ScholarOne Manuscripts / SageTrack Web site. Both QHR and Sage Publications require that authors comply with specific requirements in the preparation of their manuscripts.

Submit only Microsoft Word documents with a .doc extension. Do not submit documents with a .docx, .docm, .rtf, .pdf, or any other extension. Make sure your main manuscript document is “blinded,” containing no author information.

INFORMATION TO HAVE AVAILABLE PRIOR TO SUBMISSION

When submitting your manuscript, be prepared to provide the information listed below. Note that this information is to be entered into the online system; it is not to be included in the manuscript itself, nor should it be included in your cover letter.

Complete contact information for EVERY author must be entered into the ScholarOne Manuscripts / SageTrack system when uploading the manuscript. Although the system itself requires complete information only for the contact/corresponding author, QHR requires complete information for all authors—without exception.

Have the following information ready before you begin the submission process:

- The correct spelling of each complete author name (not just initials), and the proper author order. EVERY author—without exception—must be entered into the system.
- The proper form of address for each author (i.e., Dr., Prof., Mr., Ms., Mrs., Miss, and so forth)
- A verified email address for every author, without exception. Use extreme care when entering email addresses: many coauthors cannot be reached because the submitting author fails to enter email addresses correctly. Confirm all coauthor email addresses before beginning the submission process.
- Information on any conflict of interest
- Confirmation that the manuscript is original work, and has not been published or submitted for consideration elsewhere
- The number of figures in the manuscript, if any
- The number of tables in the manuscript, if any
- The total number of words in the manuscript (use Word’s Word Count function)

When entering data and submitting your manuscript online, do not use ALL CAPITAL LETTERS (especially for manuscript titles and author names); instead, use Title Case. Do not put a period (.) at the end of your title.

The corresponding author should be someone who will be available to respond promptly to communication from QHR and/or the publisher at any time in the review, revision, production, or publication processes. Corresponding authors are responsible for the timely communication of questions and decisions to all of their respective coauthors.

Submit your manuscript at http://mc.manuscriptcentral.com/qhr/.

If you do not already have one, you will need to establish an Author Account and select a password to access and return to the system. (Be sure to make note of your password information for later reference.)
Upload your documents into the system **in this order:**

1. Title page
2. Main manuscript
3. Figures (if any, each in a separate document, in numerical order)
4. Permissions (if needed)

If you did not upload the documents in the proper order, use the drop-down box to reorder them. Be sure to click on “Save.”

**TIMING OF THE REVIEW PROCESS**

QHR makes every effort to expedite the peer-review process. However, in attempting to secure the assistance of our expert reviewers we must sometimes accommodate their busy schedules and await their availability. **Therefore, the average time from manuscript submission to first decision is approximately three (3) months; it might be longer. Please refrain from contacting the QHR office regarding the status of your manuscript until at least three months have passed.**

**HOW TO SUBMIT A REVISED MANUSCRIPT**

If you have been invited to revise your manuscript (including after receiving an “accepted, pending revision” decision), you will be unable to retrieve the document you submitted online. Instead, revise your personal electronic copy of the original manuscript.

**If you have revised an “active” manuscript, DO NOT submit it as a new manuscript.** If the submission deadline has passed, the system will not allow you to upload the revision. If this happens, please contact the QHR office and ask that the deadline be extended to allow you enough time to complete the submission. After you have sent this request, **please wait for a response from the Technical Editor; do not attempt to upload your manuscript until you have received a response.**

If you are invited to submit a revision, you will receive an email message containing comments from the reviewers and/or instructions from the editor about the revisions you are requested to make. Address the reviewer comments and follow editor instructions carefully and completely when making your changes; be as specific as possible in your response. When uploading your revision, enter (into ScholarOne Manuscripts / SageTrack, under “Author Response”) your comments concerning the changes you have made. Type your comments into the system in the space provided; **please do not upload your response comments in a separate document.**

Failure to comply completely with editor instructions for revision could result in delays, the need for additional revision, or even the rejection of your manuscript. If you believe it would be detrimental to the article to comply with the requested changes, state your argument in your revision comments. **Following consideration, the editor’s decision will be final.**

Once the revised manuscript is prepared, upload it and submit it through your Author Center:

To submit a revised manuscript, logon to [http://mc.manuscriptcentral.com/qhr/](http://mc.manuscriptcentral.com/qhr/) and enter your Author Center, where you will find your manuscript listed under “Manuscripts with Decisions.” In the table, under “Actions,” click on “Create a Revision.” (Your manuscript ID number will automatically be appended to denote a revision; for example, QHR-2010-1234 would become QHR-2010-1234.R1.) Follow the prompts to complete your submission.

Upload your documents in the proper order (see instructions in **How to Submit a New Manuscript**, above).

**Important:** Delete all earlier versions of the manuscript before completing the submission of the revision, but do not delete your title page (unless you have replaced it with an updated or final version) or figures (unless you have revised them or have been asked by the editor to remove them). **You must upload your own documents; do not send them to QHR for uploading.**
We ask that authors complete and submit revisions within 60 days (30 days for “accept, pending revision” decisions). Note that these are not calendar months; the ScholarOne Manuscripts / SageTrack system is preset to automatically establish these deadlines by counting the exact number of days from the date and time when revision decisions are sent out—not when you read the decision letter. This helps to ensure that your manuscript does not become outdated during the revision process. If you are unable to meet this deadline, or if the system indicates that you have missed the deadline, contact QHR at QHR-Journal@nurs.utah.edu for an extension of time. Unless you have been specifically instructed to do so, DO NOT submit your revision as a “new” manuscript.

At the editor’s discretion, your revised manuscript might be sent back out for further review, usually to the original reviewers.

**PUBLISH AHEAD OF PRINT**

Sage Publications, Inc., the publisher of *QHR*, provides a feature called **OnlineFirst**. Through this feature, completed articles (those for which the production process has been completed) are published online before the print versions are available. These articles are both accessible and citable prior to the publication of the printed journal issue. For more information about OnlineFirst, visit http://online.sagepub.com/sphelp/SageColl_PAP.dtl.

**POLICY ON NIH PUBLICATION REQUIREMENTS**

The following information was received from Sage Publications on May 29, 2008, and is included herein by permission of Sage Publications:

“We have received a significant number of inquiries from journal authors [about] our policy regarding NIH compliance, which mandates that the final, peer-reviewed manuscripts, upon acceptance for publication, be made publicly available no later than 12 months after the official date of publication.

“The NIH policy meets our own posting policy at the first anniversary of the date of the NIH-funded article’s publication. As stated on the contributor agreement, our policy is as follows:

“No sooner than twelve (12) months after publication of the Contribution in the print edition of the Journal, the Contributor-created version of all or part of the Contribution and abstract as accepted for publication by the Journal (i.e., updated to include all changes made during the peer-review and editing process) may be posted on any non-commercial Web site or repository, provided that such electronic copy includes a hyperlink to the published version of the Contribution on the SAGE Journals Online Web site, together with the following text: ‘The final, definitive version of the article is available at http://online.sagepub.com/’. Contributor is not permitted to post the SAGE PDF version of the published Contribution on any Web site or repository.

“Authors asking about the NIH requirement should be advised that they are free to provide their own author-created copies of the peer-reviewed version of the article to PubMedCentral and other public repositories with the understanding that the article will not be made available until 12 months after publication.”